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Preface 

Summary of Revisions 

 
Items added to this document and not included in the October 2010 Estimating Manual 
include: 
 
 Information on the Distribution and Review of Estimates in the Regions. This 

discusses how estimates from Scoping through PS&E are to be distributed. 
 Information on the Distribution of the Final Engineer’s Estimate specifically. 
 ODOT Policy and Procedure regarding the Security/Confidentiality of the Final 

Engineer’s Estimate. 
 A comprehensive breakdown of Estimator Group Numbers. 
 Appendix E includes a memo which outlines ODOT’s policy for the management 

of the Engineer’s Estimate. 
 
If more information is needed on these topics, or topics not covered in this manual, 
please contact the Office of Project Letting. 
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Purpose of Manual 

 
The purpose of the Oregon Department of Transportation Estimating Manual is to 
provide a resource for understanding ODOT’s construction estimating process. 
Estimates are developed as early as the scoping phase of a project and are continually 
revised and updated until the project incurs actual construction costs. This manual 
addresses construction plan development, which is part of the advanced plans phase, 
and beyond. This manual will help give an understanding of the estimating process, the 
Final Engineer’s Estimate and an overview of the Trns•port system. An in depth section 
about the Trns•port Estimator module is included as well.  Future revisions of this 
manual will expand to include earlier estimating techniques and practices. 
 
Estimates must follow the latest version of the standard specifications for construction, 
which is currently the 2008 edition of the Oregon Standard Specifications.  This latest 
version can be found on the ODOT Specifications website. 
 
Each project is unique. To accurately develop an estimate of the construction costs for a 
project, an estimator must be capable of mentally constructing the project and then 
accounting for all the activities necessary to complete it. Many of the best cost 
Estimators are knowledgeable in both transportation design and construction. 
 
While estimating a project, Estimators should be shielded from pressures to keep 
estimates within programmed or desired amounts based on available funding. 
Estimators should be free to establish what they consider to be a fair and reasonable 
estimate based on the scope and schedule of the project and anticipated bidding 
conditions (i.e. local and global market conditions). 
 

http://www.oregon.gov/ODOT/HWY/SPECS/standard_specifications.shtml
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Training Information 

Training Classes 

Users of Trns•port Estimator must receive training before ODOT will grant permission to 
use the Trns•port Estimator software. In addition, Consultants and Local Agencies must 
have ODOT User ID's. Participants taking these classes should be using Trns•port 
Estimator for their jobs in scoping, PS&E, cost of components, and budgeting. ODOT 
training is available to Local Agency staff, Consultants, and ODOT employees.   
 
There are four classes that look at different aspects of Trns•port Estimator and how it can 
be used for scoping, PS&E, costing of components, and budgeting. There are typically 
two classes a week, every other week throughout the year. These classes are centered 
on the needs of the participants in each class relating to Trns•port Estimator. 
 
For more information or to sign up for a class contact ODOT Roadway Engineering at 
503-986-3714. 
 

http://www.oregon.gov/ODOT/HWY/TRAFFIC-ROADWAY/
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Definitions 

 
American Association of State Highway Transportation Officials (AASHTO) – AASHTO 

provides technical services and transportation related policies to support states in 
their efforts to efficiently and safely move people and goods. 

 
Cost – Cost is an expense paid out. It implies an expense was actually incurred. 
 
Final Engineer’s Estimate (FEE) – The Final Engineer’s Estimate is the final estimate 

used for bid opening, evaluation, recommendation, and contract award. The FEE 
includes addenda between PS&E submittal and bid opening. 

 
 Federal Highway Administration (FHWA) – FHWA is part of the U.S. Department of 

Transportation. FHWA is in charge of ensuring America’s roads and highways 
continue to be the safest and most technologically up-to-date. FHWA helps 
states by providing financial and technical support for constructing, improving, 
and preserving America’s highway system. 

 
Office of Project Letting (OPL) – A unit within ODOT’s Technical Services Branch that 

includes Pre-Letting, Specifications, Estimating, and Quality Assurance for 
Design. OPL provides the professional conduit to assist the project team in 
successfully delivering a project to bid. 

 
ODOT’s Procurement Office – Construction Section (OPO – Con) – ODOT’s 

Procurement Office – Construction Contracting Section is within the Support 
Services Branch and is responsible for the advertising, bid opening, and 
awarding tasks for highway construction projects for ODOT’s Procurement Office 

 
Price – Price is generally an estimate or quote – a “bid”. It implies that an agreed upon 

rate of exchange between two parties for services is to be performed. 
 
Plans, Specifications and Estimate (PS&E) – A scheduled milestone event wherein all 

elements of a project necessary for ODOT to advertise for bid have been 
delivered to, and accepted as complete by ODOT’s Office of Project Letting. 

 
PS&E Provider – The organization or business entity providing the complete PS&E 

package. This may be an ODOT Region, a Local Agency, or a private consulting 
firm. 

 
Zero Cost Estimate – An estimate showing only bid items and their quantities.  No unit 

prices are included. 

http://www.oregon.gov/ODOT/HWY/PDU/docs/pdf/PDLTNotice02.pdf
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Estimating Methods 

 
The critical review of any bid depends on the reliability of the estimate it is being 
compared to. The Final Engineer’s Estimate should reflect the amount the contracting 
agency considers fair and reasonable, and is willing to pay for performance of the 
proposed work. Under-estimating causes project delay because additional funding has 
to be arranged to meet additional costs. Over-estimating causes inefficient use of funds, 
which could be used for other projects. There are three main methods to create an 
estimate: Bid Based, Cost Based, and a combination of the two. 
 

 Bid Based: This method uses historical data, unit prices, and quantities from 
recently awarded contracts to form an estimate.  This approach is a cost-effective 
method to develop the final engineer’s estimate, but solely relying on historical 
data may not be appropriate when the data is based on a non-competitive 
bidding environment. Under this approach, bid data is summarized and adjusted 
for project conditions (i.e., project location, size, quantities, etc.) and the general 
market conditions. This method requires the least amount of time and personnel 
to develop and produce an adequate estimate for use in budgeting/programming, 
as long as competitive bid prices are used. Non-competitive and unbalanced 
bidding practices are the least recognizable using this method.  

 
 Cost Based: The actual cost method takes into consideration factors related to 

performance of the work (i.e., the current cost of labor, equipment, materials, 
sequence of operations, production rates, and a reasonable value of overhead 
and profit). This method requires the estimator to have a good working 
knowledge of construction methods and equipment. The estimator should have 
resources available for determining production rates from actual work performed 
by the contracting industry on similar types of projects, as well as resources for 
determining current construction methods and equipment.  While adjustments for 
current market conditions may be required, this method typically produces an 
accurate estimate and is useful in the bid review process, aiding the decision to 
award or reject the project.  This method is more time consuming and may not be 
practical for all projects. 

 
 Combination: This method combines the use of the Bid Based and Cost Based 

methods. With this method, ODOT knows the potential bidders, market trends 
and construction methods. Most projects contain a small number of items that 
together comprise a significant portion (e.g. 75 percent) of the total cost. These 
major contract items may include Portland cement concrete pavement, structural 
concrete, structural steel, asphalt concrete pavement, embankment, or other 
major items of work within the contract. ODOT collects information related to 
local market prices of materials from materials and equipment manufacturers, 
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dealers, and rental companies to obtain current cost information on a regular 
basis. The remaining items are estimated based on historical prices and adjusted 
as appropriate for the specific project.  
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Project Items 

Biddable vs. Non-Biddable  

Bid items for which work will be paid are considered biddable items. All other items, not 
in the project bid list, such as contingency, engineering, and anticipated items are non-
biddable.  Items that are non-biddable are identified (and approved if required) prior to 
delivering the project to Office of Project-Letting.  

Bid Item  

The standard specifications and special provisions establish the bid items for which 
work will be paid. Except for the items identified in the specifications as incidental, all 
work shown on the plans require bid items. Use bid items from the established Standard 
Bid Item List. Use of bid items that are not on the established list will require written 
special provisions, including materials, construction, measurement, and payment.  
 
A bid item is considered to be a specific unit of work for which a price is provided in the 
contract. Combining two or more existing bid items into one bid item is not 
recommended. Combining bid items creates a flawed bid history for the particular bid 
item used and leads to highly inaccurate costs and misinterpretation by contractors. 

Lump Sum Items 

The use of lump sum items is not recommended.  Lump sum items are often used when 
an item of work can only be defined in general terms. For example, when the finished 
product can be defined but not all of the components or details can be easily 
determined, the use of lump sum items is acceptable. This can make estimating lump 
sum items difficult for the estimator. The more information provided and smaller 
breakdown of  lump sum items an estimator has available, the greater the likelihood an 
accurate lump sum estimate can be developed. An estimator should define a lump sum 
item in terms of its simplest, most basic components and should consider other factors 
that are not easily estimated. By breaking up a lump sum item into smaller items of work 
which have historical data, and then applying reasonable estimated prices to those sub 
units, the estimator can accurately establish a price for the overall lump sum item. 
 
Lump sum items are divided into two categories: 

a. Standard Lump Sum Items – Standard lump sum items are identified in the 
Oregon Standard Specifications and Boiler Plate Special Provisions. Use these 
standard lump sum items as appropriate according to the Oregon Standard 
Specifications and Boiler Plate Special Provisions. Examples include 
mobilization, erosion control, steel plate girder, etc. 

http://www.oregon.gov/ODOT/HWY/SPECS/docs/bid_item_list/2008_Bid_Item_List.xls
http://www.oregon.gov/ODOT/HWY/SPECS/docs/bid_item_list/2008_Bid_Item_List.xls
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b. New Lump Sum Items – New lump sum items are items not in the Standard 
Specifications or Boiler Plate Special Provisions. New lump sum items are 
sometimes included in project specific specifications.The use of new lump sum 
items is discouraged because of higher costs to the Agency when adjustments 
must be made to the bid item. FHWA encourages the use of separate, non-lump 
sum bid items. 

 
Using lump sum items typically transfers risk to a contractor.  Contractors may raise 
prices to take on this risk. Contractors cannot necessarily rely on overruns to cover work 
they did not foresee.  Lump sum items should only be used when the following 
conditions apply: 
 

A. The lump sum item is a standard item with no appropriate alternative non-lump 
sum standard item available for use. 

B. The work is not easily defined.  The final product is known but the construction 
techniques or other components are difficult to determine. 

C. The work is complex with many components (the designer is encouraged to 
break down lump sum items to their constituent items if possible). 

D. The lump sum payment may be justified as an incentive to complete work in a 
more timely or efficient manner than if other units of measure were used. 

 
In the Trns•port Estimator module a lump sum item will be shown with an “A” at the end 
of the item number. 

Percentages for Lump Sum Items 
The following percentages have been developed to show the typical percentage range 
for specific items. These percentages should be decided before the project goes into 
the estimating phase and should be documented in the specifications for each project. 
 
Mobilization – 8.0% - Normal 

9.0% - Large earthwork projects. Large amount of equipment 
needed. 
10.0% - Structures 

 
TP&DT –   0.5% - High dollar paving projects, preservation (non-urban) 

1.0% - Normal 
1.5% - Several areas of work simultaneously where TP&DT 
(Temporary Protection & Direction of Traffic) is needed 
simultaneously 
6.0%-7.0% - Signals, Camera Installations 
Original prices generally come from TP&DT designer. If the original 
price varies significantly from the above percentages then check 
with the designer for verification. 
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Erosion Control – 0.2% 
 
Surveying –  1.0% - 1.5% 
 
Removal of Structures & Obstructions – Identify items and cost out as per sheet #2 in 
the Clearing and Grubbing worksheet 
 
Clearing and Grubbing – Identify number of Acres and cost out as per sheet #1 in the 
Clearing and Grubbing worksheet. 

Hybrid Lump Sum Items 

Hybrid lump sum items are used when lump sum items are specified in the project 
specifications. Examples of hybrid lump sum items are structural concrete, structural 
steel, bridge rail, sign supports, and clearing and grubbing. 
 
Hybrid lump sum items are very similar to regular lump sum items.  Both will show a unit 
of one on the bid summary sheet. With hybrid lump sum items the contractor will bid on 
the item as a lump sum, but the item is entered into Trns•port Estimator with a quantity 
and unit price.  Quantities and unit prices must be included in the estimate. Hybrid lump 
sum items are identified by an “A” as the last character in the item number.  
 
Data entry for these items is required . Follow the steps below. 

 With the group highlighted choose the appropriate hybrid lump sum item. 
 Enter the item quantity in the quantity box. 
 Right click and select either reference or cost sheet to price. WARNING: Do not 

enter prices at the unit price level in the upper right area within the unit price box. 
Prices entered here will not pass into the main system and data will be required 
to be re-entered into the program. 

 Highlight the item and click on the box under the Name Column. It will show a 
window that gives the option of creating a reference sheet or cost sheet price 
basis (don’t worry about the other two options). 

 For a lump sum item choose the cost sheet item. Click the green “GO” button 
and fill out the cost sheet. 

Anticipated Items  

Anticipated items are used to provide a funding mechanism for non-biddable elements 
of work that may be needed to complete a project. All anticipated items need to be 
identified prior to submitting PS&E to OPL. The use of anticipated items is acceptable 
when there is a high likelihood that non-biddable cost will be incurred. 
 
Examples of common anticipated items include: 

 Statistical asphalt bonus 

http://www.oregon.gov/ODOT/HWY/ESTIMATING/docs/Clearing_Grubbing_Worksheet.xls
http://www.oregon.gov/ODOT/HWY/ESTIMATING/docs/Clearing_Grubbing_Worksheet.xls
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 Asphalt smoothness bonus 
 Railroad flagging 
 Asphalt escalation  
 Fuel escalation  
 Steel escalation  
 Public information and relations 
 Migratory bird monitoring 

 
ODOT receives guidance from FHWA on this matter. FHWA believes that anticipated 
items should not be created for items of work that can be competitively bid. ODOT and 
FHWA’s policies discourage the use of anticipated items for unfinished and incomplete 
design work. Using anticipated items in this manner will result in negotiations between 
ODOT and the contractor,  most likely resulting in a higher price than if it had been bid 
competitively.   
 
Do not include any project work items that can be identified, quantified, designed and 
bid as an anticipated item. For the occasional special item that might need to be fixed, 
rebuilt or modified (not due to any Contractor negligence) during the progress of the 
work to complete the project, the project team can request approval for the anticipated 
item. 
 
Non-standard anticipated items must have additional approval and secured funding 
before being added to project cost. Requests for anticipated items must be approved in 
writing by the Area Manager and the OPL Manager for all non-standard anticipated 
items on all projects. FHWA must also approve non-standard anticipated items on full 
federal oversight projects. 
 
For more information on anticipated items, reference Operational Notice PD-07 and the 
PS&E Delivery Manual. 

Incidental Items 

Incidental items are considered minor work items necessary to complete an individual   
bid item or if no bid item is included in the project, (specifically identified in the Oregon 
Standard Specifications) incidentals are minor work items necessary to complete a 
specific task. Incidental items are items for which there will be no separate or additional 
payment. If the incidental work items or tasks are more than three percent of the total 
cost of a primary bid item, a separate bid item is required for the work item.  Combining 
work items or tasks, and making them incidental to other work is not appropriate and is 
not recommended. Only include the following items as incidental when there is little of 
this type of work on the project.  

 
00210.90 - Mobilization  
00310.90 - Removal of Structures and Obstructions  

http://www.oregon.gov/ODOT/HWY/PDU/docs/pdf/PDLTNotice07.pdf
http://www.oregon.gov/ODOT/HWY/SEOPL/docs/manuals/a-users-guide-to-pse-delivery_FINAL.pdf


 

 
 

 Estimating Manual 
ODOT October 2010 10 
   

 

00320.90 - Clearing and Grubbing 
00335.90 - Blasting Methods and Protection of Excavation Backslopes 
00340.90 - Watering  
00370.90 - Finishing Roadbeds and Slopes  
00445.91 - Sanitary, Storm, Culvert, Siphon, and Irrigation Pipe  
00495.90 - Trench Resurfacing  
00610.90 - Reconditioning Existing Roadway  
00706.90 - Emulsified Asphalt Slurry Seal Surfacing 

Entering Incidental and Breakdown Data 
To enter incidental and breakdown data follow the directions below. 

 Highlight the selected bid item.  Right click and select “Cost Sheet”. 
 Highlight the cost sheet description in the tree view. 
 Select the “Materials” tab at the bottom of the sheet 
 Highlight the box under the “Description” box in the lower right side of the page 

and enter a description of the incidental or breakdown component of the bid item. 
 Select the box under the unit’s box and use the drop down menu to select the 

unit of measure. 
 Select the box under the quantities box and enter the quantity that is identified in 

the special conditions for the work item. 
 Select the box under the “Unit Price” box and enter the estimated unit price for 

the work component. 
 Select “Enter” and repeat the process for every incidental item or breakdown item 

not already listed in the unit price or cost breakdown schedule. 
 Highlight the selected bid item again and verify that all the bid components are 

selected. Note: this will prompt a “Honda” error that is ignored in these cases. 
 Select the “Notes” tab in the upper right half of the screen; enter the date of the 

information provided in the cost breakdown, the source of the data, and the 
contact person for the data. 

 



 

 
 

 Estimating Manual 
ODOT October 2010 11 
   

 

Overview of Trns•port  

 
Trns•port is an information system for managing transportation plans within a large 
agency, such as Oregon Department of Transportation, that is owned by AASHTO 
(American Association of State Highway Transportation Officials). This system starts the 
process from the planning and estimating stages through the development of bidding 
documents, letting and contract award, and management of the construction operations. 
ODOT, like most state departments of transportation, uses the Trns•port system for 
projects.  
 
The Trns•port Programs used by ODOT Office of Project-Letting include:  

 BAM/DSS 
 Estimator 
 Proposal Estimates System (PES) 
 Letting and Award System (LAS) 
 Expedite 
 Bid Express 

 



 

Flowchart of the Trns•port System. 
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The above flow chart shows how all the different Trns•port modules work together.  The 
only modules ODOT does not subscribe to are the CAS (Construction Administration 
System) , Site Manager, and CES (Cost Estimation System). These two modules are 
used once the project is in the actual construction phase; ODOT uses the legacy 
Contract Payment System for this phase.  The following sections of this Manual include 
descriptions for all eight different Trns•port modules plus Bid Express.  Bid Express is 
not part of the Trns•port system but works in conjunction with Expedite to turn proposal 
data into bid data. 
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Description of Different Trns•port Modules 

BAM/DSS (Decision Support System) 
BAMS/DSS is the software product for analysis of highway construction bid and 
project data. Data passes through this core analysis module, called the Decision 
Support System (DSS) into its database from the other Trns•port modules.  
Analysis and data from DSS is passed back to a particular module, e.g. 
Estimator, to provide additional functionality.  DSS uses the statistical software 
SAS as a backbone.   
 
DSS contains a historical database specifically designed to assist in the planning 
and budgeting process as well as provide decision support in bid review and 
evaluation, collusion detection, vendor (contractor) analysis, and item price 
estimation. Trns•port BAMS/DSS maintains a historical repository of contract 
information from all phases of the contract life-cycle, and has built-in analysis 
models to support the wide variety of management information requirements. 
Trns•port BAMS/DSS also provides ad hoc analysis capabilities which allow 
ODOT to use the information contained in BAMS/DSS to respond to a wide 
variety of executive and legislative requests. 
 
Office of Project Letting staff uses the BAM/DSS module. 

Estimator 
Estimator is a stand alone software package specifically designed for estimating 
the cost of highway construction projects.  Estimator uses bid-based item price 
estimation data from DSS (Decision Support System). Estimator works well for 
distributing the estimation function throughout Region offices and for exchanging 
data with design consulting firms.  
 
Project team Specification Writers and Estimators create the project estimate in 
Estimator and submit the Estimator file to the Office of Project Letting. 

CES (Cost Estimation System) 
The Cost Estimation System is a PC-based job and program cost estimating and 
planning tool. It provides a highly productive environment for preparation of 
parametric, cost-based and bid-based job cost estimates. CES provides a full 
range of cost estimating and scheduling support capabilities, from preliminary 
estimates needed for program planning to the final engineer's estimate required 
for award approval. Once a job is defined in CES and an estimate is produced, 
CES supports the combination of jobs into a work program involving setting 
priorities and considering alternate programs for construction planning over a 
multi-year period. In addition, CES manages job and program scheduling with 
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funding analysis and budget projections, including inflation adjustments and 
alternate inflation scenarios. 
 
ODOT does not subscribe to this module. 

PES (Proposal and Estimates System) 
The PES module has the functions associated with preparing the detailed cost 
estimate for the PS&E package and proposal documents for the contract bid 
letting. PES capabilities include the automated generation of item cost estimates 
from the historical bid data stored in BAMS/DSS for the Detailed Cost Estimate 
Report. PES also automates the creation of bidding proposals from project 
information without the re-entry of item level information. Multiple projects can be 
combined into a single proposal with common items combined and estimated. 
PES has been designed to offer maximum flexibility in project definition, including 
provision for multiple funding sources, non-participating items, alternate items 
and item-category specifications, the identification of special provisions and 
supplemental specifications, and addendum processing.  
 
OPL’s Pre-letting staff loads the estimator files into PES to create the Bid Sheets 
and to track project estimates. ODOT’s Procurement Office also uses PES for 
reports. 
 
Key PES Reports:  
•Preliminary Detailed Cost Estimate and Funding Summary  
•Proposal Schedule and Special Provisions Listing  
•Proposal Schedule with Estimated Prices  
•DBE/WBE Item Estimate Report 

LAS (Letting and Awards System) 
LAS is used in advertising bids, processing bid information, evaluating bids and 
making award decisions. The Letting and Award System (Trns•port/LAS) 
provides on-line and batch data entry with full edit checking and verification for 
vendor bids. It produces the bid tabulation report, and performs analyses on 
received bids. Additionally, LAS maintains the plan holder’s list, produces mailing 
lists, and maintains information for invoicing vendors for proposals and plans 
purchased.  
 
Upon proposal award, a Final Detailed Cost Estimate report and a Contract 
Schedule of Prices report can be produced using the awarded contractor's 
prices, and then the data can be passed to the DSS module.  ODOT also uses 
InfoTech’s Electronic Bidding System. Bid Express, which includes a program, 
Expedite, to create electronic proposals from Trns•port PES data. This enables 
contractors to bid electronically on proposals, and ODOT to load electronic bids 
into Trns•port LAS.  
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OPL’s Estimators use LAS to pick the low bidder and to analyze bids and bid 
items. LAS is used in conjunction with PES. 
 
Key LAS Reports:  
•Notice to Contractors  
•Bid Tab Edit  
•Bid Letting Summary  
•Bid Tab Analysis  
•Low Bid Analysis  
•Contract Schedule of Prices  
•Final Detailed Cost Estimate and Funding Summary 

Expedite 
Expedite allows bidders to receive proposal information, enter all information 
required for a valid proposal, and submit item bids. Item extensions, section and 
proposal totals, and DBE percentages are calculated and displayed immediately. 
The software alerts contractors to omissions and incorrect alternates and 
prevents computation errors. Expedite can exchange data with Trns•port PES, 
LAS, and similar systems, and can share proposal information with other word 
processing, database, or spreadsheet software. Standard, customizable reports 
are provided (Bid Submission Report, Bid Error Report, and Amendment Report), 
as well as a custom report feature.  
 
Contractors use Expedite to send the bid information confidentially to OPO via  
Bid Express.  

Bid Express 
Another component of the online bidding process is Bid Express,  a web-based 
subscription service which provides one-stop access to electronic bid information 
from participating state transportation departments. Prospective bidders using 
Bid Express can access an agency's historical and current letting information as 
well as schedules of prices and items for each contract, eligible bidders, plan 
holder lists, bid tabulations, and addenda. Contractors have instant access to bid 
information from all over the country. Bid Express enables secure online bid 
submission. By using Bid Express in conjunction with Expedite, contractors can 
download letting information, prepare bids, and submit proposals electronically 
with improved accuracy and time-efficiency. 
 
ODOT actively uses Bid Express as the electronic bidding service for contractors 
to submit bids. 

Site Manager 
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Site Manager is a comprehensive client/server based construction management 
tool. It allows for data entry, tracking, reporting, and analysis of contract data 
from contact award through finalization. The main functions of Site Manager are 
daily work reports, contract records, contract administration, contract payments 
and materials management. 
 
ODOT does not subscribe to this module. 

CAS (Construction Administration System) 
Construction Administration System manages contract information from award to 
final payment. This module addresses ODOT’s Construction Section’s needs 
regarding contractor payments (partial/final), funding participation allocation, 
subcontract approval, and tracking and changes to original contract 
specifications (change orders and supplemental agreements). 
 
ODOT does not subscribe to this module 
 

http://www.oregon.gov/ODOT/HWY/CONSTRUCTION/
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Trns•port Estimator 

The many aspects of Trns•port Estimator will be explained in detail in the following 
sections.  For Estimators needing a quick review on how to create an estimate in 
Trns•port Estimator  there is a list of basic steps in Appendix  A. 

Catalog 

Trns•port Estimator is a stand alone software package specifically designed for 
estimating the cost of highway construction projects.  Within Trns•port Estimator  the 
data for producing estimates is stored in one or more catalogs which include item 
related code tables and historical item prices.  Catalogs are made available for use in 
the Trns•port Estimator module and can be found in the Bid History Catalogs section of 
the ODOT Estimator website. Catalogs are updated semiannually and are only useful 
when downloaded and used in conjunction with Trns•port Estimator.  
 
There are two options of catalogs that can be downloaded on the website. One option 
(i.e. “2009 – 1st Qtr – 1yr”) has one year of bid history.  The second option (i.e. ”2009 – 
1st Qtr – 2yr”) has two years of bid history.  With either catalog it is best to have an 
understanding of the market area and market pricing. In most cases the catalog with 
two years of data will be used. This catalog is the default catalog and is more stable in 
the pricing structure of the items. The catalog with one year of data is used mostly for 
trending and should be used with great caution since it could put the bid in risk of being 
unbalanced.  
 
Set your Trns•port Estimator to the current catalogs on the OPL server. 

1) Open Trns•port Estimator and select “Tools” > “Global Options”.  
2) In the “Estimator Options” window select the URLs tab.  
3) Point Estimator to the catalog location on the server. 

a. Click the “Browse” button to the right of the “Catalog Path” (HTTP of file) 
field. 

b. In the “Folder” field, enter “\\s-salemrev-22\EstShare\Cat”.  
c. Click on “Apply” > “OK” 

4) Verify that catalogs can be accessed. 
a. Select “Tools” > “Open Catalog”. 
b. The catalogs should be visible. If not, call your Estimator system 

administrator to verify access permission. 
 
Verify the current catalog is being used.  If not, download and import the most current 
catalog into Estimator. 

http://www.oregon.gov/ODOT/HWY/ESTIMATING/estimator.shtml#Bid_History_Catalogs
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Skeleton File 

When preparing an estimate in Trns•port Estimator, a project skeleton file can be 
imported as the initial step in creating an estimate. This file contains information that will 
help with the estimating process. These files contain general project information and 
standard item groups to which items, quantities, and cost estimates can be added.  
 
The Skeleton file can be found on the ODOT Estimating website under the Project 
Skeleton File Section.   

 From the website, click on the Region the project is in.  This will link to the ftp site 
where the skeleton files are stored.  Save the skeleton file to a location on your 
PC. 

 Each project that is being bid on will have a specific skeleton file.  
 Within the skeleton file the project key number, specification year, description, 

and groups that the items will be placed in are given.  

Importing a File to Trns•port Estimator 
To import a file into Trns•port Estimator, select “File” > “Import”.  Once the import screen 
opens up locate the file and click “open”. 

Mandatory Parameters 

After the skeleton file is imported, the estimating process can be started in Trns•port 
Estimator. There are four mandatory settings that must be followed in order to complete 
the estimate correctly. 
 

1. Set your “Caps Lock” to ensure all text is in capital letters.  Trns•port 
Estimator and the client Trns•port modules only recognize capital letters. 

2. Do not modify the “Description” imported via the skeleton file. The 
description on the estimate page must match the official title in PCS.  

3. Always check “Only Trns•port Items and Codes Allowed”. When your 
estimate file is open, select “Edit” > “Estimate Options” and check the box next to 
“Only Trns•port Items and Codes Allowed”. 

4. Always fill out all fields on Page 1. When starting a new estimate, all header 
information on Page 1 must be completely filled out (see Initial Estimate Page). 

Initial Estimate Page 

Once Trns•port Estimator is open, and before any groups or items are added, users 
must make sure that the two pages of the Estimate file are completely filled out. Below 
are lists of the fields on the two pages which need to be completed. 

http://www.oregon.gov/ODOT/HWY/ESTIMATING/estimator.shtml#Project_Skeleton_Files


 

Description of All Fields on Estimate Page 1 

 
 

A) Estimate ID: Type the key number here. 
B) Spec Year: This is the year of the specification book that is being used. The 

current default is “08”. 
C) Base Date: This is the bid date for the project. 
D) Unit System: The units that are used for the bid. Enter “E” for the English 

System. 
E) Latitude of Midpoint/Longitude of Midpoint: This is the center point location of the 

project. This information must be entered in as Degrees-Minutes-Seconds 
and not decimal degrees. 

F) District Field: This is used to identify the Region number. Do not enter the 
maintenance district. 

G) Federal/State Project Number: Federal or State project number for the 
Construction Engineering phase.   

H) Description: The official project name from the STIP, originating with PCS.  Do 
not modify this description from what originates with the skeleton file. 
This name must also match other project documents exactly. 

I) Work Type: This should be selected based on the area of work with the highest 
estimated cost. See Appendix B for the list of items. 

J) Highway Type: Select the type of highway for the project.  
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K) Urban/Rural Type: Choose the setting for where the project is located. For help in 
determining this, refer to chapters 7 and 8 of ODOT’s Highway Design Manual. 

L) Season: This should be the season for when the project is being completed and 
not when the work is being bid. Jobs over one year in duration should use the 
summer season.  

M) County: This is the county where the project is going to be completed. 
N) Contingency %:  This is the percentage for the contingency account.  This must 

be set to the default of 3.5%. 

Description of All fields on Estimate Page 2 

 
A) Estimated By: Name of the person creating the estimate. 
B) Checked By: For the person checking the estimate. 
C) Approved By: For the person who approves the estimate. 
D) Estimate type: Not currently used. 
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http://www.oregon.gov/ODOT/HWY/ENGSERVICES/hwy_manuals.shtml


 

Notes Tab in Estimate File 

 
A) Notes that are entered here are used to communicate with OPL and cost 

Estimators. Useful information to add into the notes tab includes: 
a. If there is an unusual bid items selected 
b. If incidental items are selected 
c. If further assistance will be needed at the point of document review. 

Ways to Create an Estimate in Estimator 

There are two main ways to create an estimate in Trns•port Estimator: build an estimate 
from scratch in the skeleton file or copy information from a template into the skeleton file 
for a project.  

Building an Estimate From Scratch 

Verify the skeleton file has been imported with the correct key number from the Region 
folder.  To start building the estimate, follow the directions below: 
 

1. Open all the groups for viewing. 
2. Make additions and changes to the group descriptions as required.   If 

necessary, add groups. 
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3. Adjust the group numbers to sequentially increase in increments of 10, 5, or 1 as 
needed for the project. Note: categories 1200 and above are reserved groups. 
Do not select numbers above 1200 for group items except 9400 and 9800. 

4. Primary group numbers match the Oregon Standard Specifications for 
Construction parts. Added groups use the third and forth digits within the primary 
group. Always use 9400 for anticipated items and 9800 for construction 
engineering.  Group 1200 is for bid items added by addenda during project 
advertisement. 

5. Make additions and changes to bid items as well as add unit items as required. 
When adding items, maintain the bid item order that is customary to ODOT’s bid 
item list. Do not re-number estimate items until the item entry process is 
completed. 

6. For miscellaneous items enter the supplemental bid item description in the 
Supplemental Description box. This will be the bid item name on the bid 
schedule. 

7. Provide information in the “Notes” tab when needed to communicate with OPL 
and cost Estimators. 

8. Verify data entry. From the “Edit” menu choose “Verify Estimate”. This provides a 
log of data anomalies. In a few cases, it is also used as an error editor. 

9. Save the file on a Region approved and secure folder. Do not re-save work in the 
skeleton file. 

Copying an Estimate from a Template 
Standard templates exist  which can be used for large projects that are developed and 
maintained by OPL’s Estimators. These templates are provided in the Region folder. 
Users can copy entire groups or  individual items from the template into the skeleton file 
that is open in Estimator. Move the group or item number as needed to find the proper 
location in the skeleton file. 
 
Templates are best used with no prices (cost, reference or bid based) attached to the 
bid item. This allows printing of the summary sheet without prices attached. The 
alternative is to turn off the check box for each price item to allow printing without prices. 
 
Pricing after copying templates and bid items is managed as follows:  

 Go to “Edit” > “Update Price Information”  
 From “Update Price Information” select  “Refresh Time Dependant Data 

and Cost Sheet Structure”.  
 

This process replaces old cost data with prices from the price catalog the Estimator is 
currently pointing to (the option the Estimator chose when they started the program). 
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Groups 

In Estimator a group is an overall heading for related items in an estimate. An example 
is “Wearing Surfaces”, which could include items such as Emulsified Asphalt in Tack 
Coat, Level 3 ½” Dense HMAC and Concrete Walkway, among others. 

Group Numbers 
 
Standard Group Numbers are given below: 

 Group 0200 – Temporary Features and Appurtenances* 
 Group 0300 – Roadwork 
 Group 0400 – Drainage and Sewers 
 Group 0500 – Structures (Further Breakdown Below) 

o Groups 0500-0519 – Cast-In-Place Structures 
o Groups 0520-0539 – Pre-Cast Structures 
o Groups 0540-0549 – Cast-In-Place Retaining Walls 
o Groups 0550-0559 – Steel Structures 
o Groups 0560-0569 – Pre-Cast Sound Walls 
o Groups 0570-0599 – Miscellaneous Structures 

 Group 0600 – Bases 
 Group 0700 – Wearing Surfaces 
 Group 0800 – Permanent Traffic Safety and Guidance Devices 
 Group 0900 – Permanent Traffic Control and Illumination Systems 
 Group 1000 – Right-of-Way Development and Control 
 Group 1100 – Water Supply Systems 
 Group 9400 – Anticipated Additional Items 
 Group 9800 – Construction Engineering 

 
*NOTE: The “Training” line item should be included in the 0200 Group 

Adding a Group 
There are two ways to add a group: 

1. Click on “Edit” > “Add Group”. 
2. Or, right click on the Estimate file in the view on the left side of the screen and 

select “Add Group.” 
 
HELPFUL HINT: Once a group is created, more can be added by right clicking on the 
first group and then copying and pasting it. 

Adding a Group Header 
Click on the group to open the group information. Enter in the group number and add a 
short description to identify the group. The groups should be numbered in intervals of 
ten. By adding the group number and the short description, Estimators will know what 



 

 
 

 Estimating Manual 
ODOT October 2010 24 
   

 

items are going to be placed there. For bridges, include the bridge number in the 
description. Each bridge or structure is its own group, with its own set of bid items. 

Bid Items 

Bid items are the means by which the contract work is paid. 

Adding an Item 
1. Click on the Group that the bid item needs to be added to.  
2. Click on the space below the item number on the lower half of the screen.  
3. Select the drop down arrow and search for the item from the full standard bid 

item list (or begin typing the bid item code to go immediately to nearby items).  
4. Click on the item when it is found and the item information appears on the line. 

The designer’s quantity will also be entered on this same line.  
5. Click on the next empty line and repeat the process until all items and quantities 

are entered for that group. 

Supplemental Descriptions 
Enter the supplemental bid item description only when creating an item through the use 
of a miscellaneous (9Z9) item. This description will be the bid item name when the 
project is set up for advertisement. 

Adding Unit Prices 
Click on the item listed on the tree to the left or hit the green “GO” button on the line just 
created above. This takes you to the detailed information for each item. This is where 
unit price information is added. One or two unit prices may already have been 
automatically listed here; a Reference Price that represents the statewide average from 
the current catalog, and/or a Bid-Based unit price that represents an average regional 
price calculated from the current catalog. To enter the designer’s unit price (or 
estimator’s unit price) follow the directions for each of the boxes named below: 

 Name – Click in this box and a window opens to select a “Price Basis Type”. 
Select “Reference Price” and click “OK”. Enter the unit price and type “DES” in 
the Name box for the designer (“EST” for the estimator) who is the source of the 
unit price. 

 Active – These check boxes allow the estimator to choose which unit price to 
make “active”. The active price is the one that will show in the estimate. Be sure 
only one box is checked – the program will add the unit prices together if multiple 
boxes checked. 

Breakdown of the Item Number 
The item number is a set of numbers and letters that help to describe the item. Below is 
an example item number: 
 Example item number:   0225-2C00400 E 
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 The first four numbers (0225) in the item number are the specification 
number that item falls under. 

 The dash following the first four numbers shows that this item is in the 
English unit system.  If the dash were replaced with a dot (•) then it would 
be in the metric unit system. 

 The last letter in the item number (E) shows the unit of measure that the 
item is. The “E” stands for each. 

To view what all the last letters in the item number mean see Appendix C. 

9Z9 Items 
9Z9 items are miscellaneous items that are used for items that don’t appear on the 
ODOT Bid Item List. Use miscellaneous (9Z9) bid items only in situations where no 
standard bid item exists.  Enter the name of the item in the Supplemental Description 
box so it appears on the bid list. All unit price information is manually entered for these 
items. These items are one of a kind, non-recurring bid items. This is only to be used 
when absolutely necessary.  
 
HELPFUL HINT: If a 9Z9 item is absolutely required, find an existing bid item that 
comes close to the 9Z9 bid item and revise the description. Then estimate and save. 

Saving Estimates 

Note: before saving an estimate the “Verify Estimate” option should be selected under 
the “Edit” dropdown window and all errors need to be corrected. 

Settings for Where Files are Saved 
To make sure that the information and the bids are getting saved to the right location 
complete the following steps.  

1. Select the “Global Options” from the “Tools” menu. 
2. Click on the “URL’s Tab.” This page contains the paths for the catalog directory, 

the estimate directory, and the template folder. 
3. The “Estimate Folder” path is the directory to which new estimates are saved. 

Default to Local Drive C:\Estimator directory. 
4. The “Template Folder” path is the directory where estimate templates are kept. 

 
Remember that Trns•port Estimator Global Options are set to SAVE every 15 minutes. 
However, save often in case of a power outage etc. Select “Save As” for the “File” menu 
the first time it is being saved. Set up the drive and folder where the estimates should 
be saved. For file sharing of the estimates with a team, there will need to be a shared 
drive, i.e. S:\Trans*port\OHD etc. The key number should automatically appear in the 
File Name field. To save an estimate already saved once select “File” and “Save.” 
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How to Save a Completed Estimate File 
For completed estimates ready to be saved to the Region secure folder follow the 
directions below. 
 

1. After completing the final version of an estimate, click the “Save” option under the 
“File” drop down menu. 

2. Navigate to the folder on the local or server drive where estimate files are 
normally saved. Note: Do not save preliminary versions of an estimate in the 
Region secure folder on the Trns•port s-salemrev-22 server, this folder is 
reserved for final PS&E estimate files only. 

3. Set the “Save As” type file to “Estimate File (*EST)”, name the final estimate file 
using the key number followed by PS&E, i.e. 14030PS&E, and click the “Save” 
button. 

Export the completed estimate file formatted for upload to Trns•port PES. 
4. From the “File” drop down menu, select the “Export” option. 
5. Navigate to the folder on the local or server drive where the estimate files are 

normally saved.  
6. In the “Save As Type” field, click the drop down arrow and select “PES Project 

File” (5.4 and earlier). 
7. Name the final estimate using the key number followed by PS&E, i.e. 

14030PS&E, and click the “Save” button. 
8. Click the “Yes” button when the dialog box opens asking “Do you want this 

exported file to include category descriptions?” 
Copy the completed files to the Region Secure Folder. 

9. Navigate to where the two final estimate files are saved, one with an extension of 
*est, and another with a *dat extension. 

10. Highlight the two estimate files, go to the edit drop down menu and select the 
“Copy” option. 

11. Navigate to the Region secure folder on the Trns•port s-salemrev-22 server, 
right-click and select the ”Save” option. 

System Does Not Update for Inflation 

Trns•port Estimator does not adjust or account for inflation. The catalogs that are used 
in conjunction with Trns•port Estimator can help alleviate this problem. These catalogs 
look at data from the past two years which helps provide a more stable price structure.  
The only way for an estimator to adjust for inflation is to understand and have 
experience dealing with the market and prices.  It is best to check with ODOT staff in 
OPL, who perform cost estimates everyday and are close to the information, to get a 
better idea of how the market is doing, but it can still be very hard to predict.  Because 
market prices can be so volatile, the price at the time of bid is taken to be the final price 
and  is locked into place by the contract.   
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Additional Information to Remember 
The following list includes items that should be kept in mind when using Trns•port 
Estimator to create a bid: 

 Quantities must be entered in hundredths or larger. There should be no entries to 
three decimal places. 

 Prices must be entered in whole cents – no portions of cents. Note: Trns•port 
Estimator often shows numbers in portions of cents.  Ignore this and do not 
attempt to change or round entries internal to the system. 

 
 
Both these concerns are automatically addressed when “Only Trns•port Items and 
Codes Allowed” is selected. Accomplish this by: 

1. Select “Edit” > “Estimate Options” 
2. Check the Box in front of “Only Trns•port Items and Codes Allowed”.
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Escalators 

This section is for Specification Writers and Estimators accounting for fuel, asphalt, or 
steel escalation.  For each project  Specification Writers will determine if the project will 
be affected by fuel or steel escalation. They will then indicate in the specifications 
section which escalation clauses are to be added.  
 
ODOT has established several escalation clauses for specific commodity pricing.  
These clauses help account for unforeseeable price increases that may arise during the 
construction phase of a project.  For example, if a contractor opts in for fuel escalation, 
the project receives price relief in both directions as the commodity price fluctuates (i.e. 
the contractor is due money if the price of fuel rises; the contractor owes money if the 
price in fuel drops.).   
 
The Specifications Writer is encouraged to contact the Senior Cost Estimator to discuss 
questions about a specific project or circumstance. 

Fuel Escalation 

The fuel escalation worksheet can be found on ODOT’s website. Specification Writers 
use this worksheet to determine if the fuel escalation clause is needed. To utilize the 
fuel escalation worksheet the Estimator file must be exported as an Excel file with the 
file extension .xls.  From the Excel file, the bid item data for the estimate is to be copied 
and then pasted into the fuel escalation worksheet.  Additional instructions for 
completing the fuel escalation worksheet are available on ODOT’s Estimation website.   

Asphalt Escalation 

To account for asphalt escalation, the Estimator needs to go to ODOT’s website where 
they will find all the current prices of asphalt. At the website, open up the most current 
“Monthly Asphalt Cement Material Price” (MACMP) list. This list has the current price for 
asphalt for that month. This should be used when completing a bid. 

Steel Escalation 

Due to the fact that the price of steel is increasing/decreasing at a fairly predictable rate, 
and does not look like it will be changing drastically, the steel escalation clause is not 
often used. Use the steel escalation worksheet when conditions apply and the price of 
steel rises at an unforeseeable rate. This worksheet can be found on ODOT’s website. 

http://www.oregon.gov/ODOT/HWY/ESTIMATING/manuals_forms_etc.shtml
http://www.oregon.gov/ODOT/HWY/ESTIMATING/manuals_forms_etc.shtml
http://www.oregon.gov/ODOT/HWY/ESTIMATING/asphalt_fuel.shtml
http://www.oregon.gov/ODOT/HWY/SEOPL/docs/forms/steel_escalation_worksheet.xls
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Contingency Percentage 

Fixed Contingency 

The contingency percentage is used to account for added cost to the contract that may 
result from incomplete design, unforeseen and unpredictable conditions, or 
uncertainties in the project scope. This is not to be used to avoid making an accurate 
assessment of expected costs for the given project scope.  AGC (Associated General 
Contractors) and the Oregon Transportation Commission have agreed that a 
contingency percentage of 3.5 percent of total project costs should be included. ODOT 
requires the final contingency percentage to be 3.5 percent. Reference Operational 
Notice PD-08 page 5 on how to request a higher contingency. 

Variable Contingency 

When building estimates at earlier stages of a project (i.e. at preliminary or advance 
stage) using a contingency of a higher percentage may be warranted in order to better 
reflect the incomplete nature of the project at that stage. 
 

http://www.oregon.gov/ODOT/HWY/PDU/docs/pdf/PD08_v4_2.pdf
http://www.oregon.gov/ODOT/HWY/PDU/docs/pdf/PD08_v4_2.pdf


 

 
 

 Estimating Manual 
ODOT October 2010 30 
   

 

Common Mistakes 

Common Mistakes When Completing an Estimate 

Here is a list of common mistakes routinely made when an estimate is being created.  
The estimator needs to make sure the following mistakes are caught and corrected as 
they can have a large affect on the overall price of the estimate. 
 

 The wrong bid item gets picked from the Estimator bid item in the system. Always 
check to make sure that the bid item that is being selected is the correct one. 

 
 The unit of measure for the bid item is incorrect.  

 
 New bid items that are not in the system are given unit prices that are inaccurate. 

For new bid items the estimator needs to choose a bid item that closely matches 
the new item.  A supplemental description that accurately describes the item 
should be included.  For new bid items unlike any existing items the estimator 
must submit a new bid item form. 

 
 Hybrid lump sum items are used incorrectly or not used at all. Refer to the hybrid 

lump sum section and the lump sum section for clarification.  
 

 Hybrid lump sum items often get entered with quantities of one.  Make sure that 
all quantities match the actual specification quantities.  

 
 Incidental items in a project are added to the wrong bid items. Make sure that the 

incidental items are added to the correct bid item.  
 

 Miscellaneous (9Z9) items are used incorrectly. They should be used only when 
a standard item can not be found to pay for the work.  

 
 With non-biddable items the “Exclude Item from Reference Price Calculations” 

box is not checked. This box has to be checked in order for the estimate to be 
accurate. 

 
 The bid item called “Construct and Remove Detours” needs to account for both 

the installation and removal of detour materials. 
 

 Bid items are added with quantities beyond two decimal places.  
 

 The fields in Trns•port Estimator are not always filled out completely. 
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 Estimators enter incorrect percentage values for Mobilization, TP&DT, 
Construction Survey Work, Erosion Control, and Construction Engineering. 

 
 Estimators try to adjust for inflation by entering funds as contingencies. 

Contingency is 3.5 percent on all final estimates. 
 

 Relying solely on the bid history catalogs and not entering unit prices adjusted for 
the specific project. 

 
 DO NOT COPY NUMBERS/PRICES FROM EXCEL AND PASTE THEM INTO 

ESTIMATOR. This really throws off the estimate and can cause a lot of trouble. 
 
When creating an estimate always remember the four mandatory parameters and all the 
additional information. These will help to create estimates without mistakes. 
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Distribution and Review of Estimates 

Distribution of Estimates  

Scoping through DAP Estimates: 
Full detailed project estimates will be allowed to be posted on share drives or other 
central locations that can be seen by ODOT employees only. The estimate continues to 
be a secure document and should not be posted in public locations or distributed 
beyond the project team. 
 
Estimates in the scoping through the DAP estimate milestones do not look similar 
enough to the bid documents to be as high of a security risk, and the benefits to the 
project team to see the entire document when making large scoping decisions outweigh 
these risks. As the project progresses, quantities and bid items will continue to change 
and further distance the earlier estimate from the bid documents in the case of a 
security breach. Special care should be taken to prevent bid item prices from escaping. 
 
A Region may choose a more restrictive estimate review and distribution policy if 
desired. 
 

Preliminary, Advanced, Final, and PS&E estimates: 
Only the zero cost estimates can be distributed to the project team. The zero cost 
estimate shows only bid items and their quantities, omitting unit prices. On a project 
specific basis, a project team member may request to review the full estimate.  Control 
and access of this document should be taken seriously and the full estimate should not 
be posted in a central location, even including an ODOT only share drive or website. 
 
At the preliminary, advanced, final, and PS&E estimate milestone, the project should 
look a lot like the biddable project pricing and the overall estimate price is much closer 
to being accurate. In addition, at these final review stages, the focus of the review 
should stay on assuring accurate quantities and correct bid items versus focusing on 
unit costs. Widespread availability of this data risks the security of the Engineer’s 
Estimate and violates guidance from ODOT’s Audit division and FHWA. 
 
A Region may choose a more restrictive estimate review and distribution policy if 
desired. 
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Distribution of the Final Engineer’s Estimate  

Project Leaders and Local Agency Liaisons will be the primary distribution points for the 
Final Engineer’s Estimate. ODOT specifications writers will also have the Final 
Engineer’s Estimate distributed to them for projects that the ODOT specification writers 
contributed on. This will allow them to use the Final Engineer’s Estimate and send 
feedback. The Final Engineer’s Estimate will not be distributed to any non-ODOT 
specification writers or consultants.   
 
Project Leaders and Local Agency Liaisons should primarily share the Final Engineer’s 
Estimate with ODOT Area Managers when discussing funding decisions in accordance 
with Region policy. The Final Engineer’s Estimate should not be shared broadly or 
consistently with the project team, regardless of inside or outside the Agency. The 
official Final Engineer’s Estimate developed by OPL is initially developed within a week 
prior to bid opening and refined with addenda and recent commodity pricing up to bid 
day. There is little value and high risk in disclosing the Final Engineer’s Estimate prior to 
bid opening, when in waiting a few more days the low bid value and actual cost of the 
project will be known. 
 
During the final phases of project development, the project team is a part of the 
development of the estimate. The estimate should NEVER be shared in whole or in 
part, outside of the immediate project team. It should never be posted on webpages or 
communicated to the public or to contractors in discussions of the project. Programmed 
budgetary numbers from STIP/PCS are disclosed through ODOT’s contract report and 
reflect a budget including the biddables, construction engineering, contingency, etc. If 
this budgetary number is discussed outside the project team, care should be taken to 
note the inclusion of these components. 
 
The Area Managers (via the Project Leaders/Local Agency Liaisons) are ultimately 
responsible for the security of the Final Engineer’s Estimate and resulting procurement 
issues that may arise. If the Area Manager determines the Final Engineer’s Estimate 
should be shared, the words “Confidential – ODOT Eyes Only” should be placed on 
every page. 
 

Review of Estimates 

The ability to use an estimate to identify scope and pricing variations is a key tool for 
project teams to manage a project throughout the design phase. Each Region should 
establish a common procedure and practice for identifying and reviewing changes 
between different phases of the project that works with the particular staffing and 
procedures in the Region.  
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This is accomplished by first reviewing the detailed cost estimate. The level of changes 
should be focused on large scope issues, not on specific line items and should be 
discussed in round values, not pennies. It is realistic that unit prices and quantities 
change in a reasonable manner over the course of the project.  
 
The lead designer, specifications writer, or Project Leader are positions which could 
develop expertise in this review.  
 
Once a standard procedure is in place, the distribution of the estimate policy listed 
above can be modified to include the position performing this function for the project. 
 
OPL is available to work with the Region to develop the best practices for this work after 
a standard procedure is in place. 
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The Role of the Office of Project Letting 

 
The Office of Project Letting (OPL) uses six main steps during the advanced stages of 
the estimating process of a project.  

1. Review of the PS&E package – The Pre-Letting Quality Engineer will conduct a 
review of the PS&E package to ensure that all the deliverables have been 
completed. This is a high-level review, checking for fatal flaws and legal 
sufficiency. OPL obtains the Chief Engineer and FHWA approvals during the 
review phase. 

2. Import Estimate into Trns•port PES – The project estimate worksheet (Estimator 
file) from the PS&E provider is imported into Trns•port PES which then connects 
to Trns•port DSS. The database is used to generate the bid sheets, Final 
Engineer’s Estimate, electronic bidding, and review of bids. 

3. Coordinate with ODOT Highway Program Office (HPO) and FHWA – OPL will 
coordinate with HPO and FHWA to obtain approval to advertise the project. On 
full federal oversight (non-exempt) projects, OPL will coordinate the FHWA PS&E 
review. 

4. Pass PS&E Documents to Contractor Plans – OPL is responsible for passing on 
the plans, special provisions, bid sheets, and advertisement to OPO Construction 
Contracting Section. OPL writes the advertisement. 

5. Final Engineer’s Estimate – OPL’s estimating group performs a review of the 
PS&E estimate on all projects (including Local Agency projects bid through 
ODOT) and produces the FEE. The FEE includes any addenda that may occur 
during advertisement and material cost adjustments between PS&E and bid 
opening.  

In all cases, ODOT’s policy is to keep the Final Engineer’s Estimate 
confidential and it is not to be disclosed to any potential bidder in whole 
or in part. 

6. Process Addenda Letters and Letters of Clarification – OPL provides a fatal flaw 
review of the addendum letter, compiles the letter (including new bid sheets), and 
sends it to OPO Construction Contracting Section for posting. 

 
This information can also be found in Operational Notice PD-07.

http://www.oregon.gov/ODOT/HWY/PDU/docs/pdf/PDLTNotice07.pdf
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 Final Engineer’s Estimate  

 
OPL estimating performs a review of the PS&E estimate on all projects that are 
received from the PS&E provider (including Local Agency projects bid through ODOT) 
and produces the Final Engineer’s Estimate.  The Final Engineer’s Estimate is produced 
by having the reviewing estimator make adjustments to unit costs on the PS&E 
estimate. Generally this means that the PS&E estimate is only being adjusted for pricing 
for active market trends, location etc. OPL does not completely redo the estimate; rather 
OPL simply assures that it is accurate and up to date with all the current prices. The 
Final Engineer’s Estimates includes any addenda that may occur during advertisement 
and material cost adjustments that account for economic market changes on items such 
as asphalt and steel between PS&E and bid opening. 
 
ODOT’s Final Engineer’s Estimates are adjusted three times as follows. 

1. After it is received for final review,  
2. One week before bid for addendums and further adjustments, and  
3. Just before the bid date when oil and steel prices move dramatically in the bids 

the prior week. 
  
Upon completion of the Final Engineer’s Estimates, the Cost Estimator will send the 
Project Leader and the Project Manager (only on projects with Construction Engineering 
done by ODOT) a brief summary showing differences between the PS&E Estimate and 
the Final Engineer’s Estimates for the major components including major biddable 
items, construction engineering, anticipated items and the total price.   
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Security/Confidentiality of the Final Engineer’s Estimate 

 
Nationwide, there are many different beliefs on whether or not to keep the Final 
Engineer’s Estimate (FEE) confidential. FHWA addresses the management of the FEE 
in a variety of Technical Advisories, but ultimately defers policy to the individual states. 
However, it is clear within the aforementioned technical advisories, and in conversation 
with FHWA staff, that they strongly prefer keeping the FEE confidential. Oregon has no 
statutory requirements that control the FEE either way. Considering this fact, it is clear 
that the management of the FEE is an ODOT policy decision. Appendix E contains an 
ODOT memo from 2004 outlining the management of the Engineer’s Estimate. 
 
Protection of the FEE is essential to maintain normal market prices and fair bid 
competition. Release of the FEE exposes the value ODOT uses to compare the low bid 
to as well as the unit prices used to determine ODOT’s estimates. Leaking of the 
Engineer’s Estimate ultimately leads to price inflation and failed procurements on ODOT 
projects. 
 
To reduce risk to the confidentiality of the FEE and ODOT, it is paramount that all 
dealings with the FEE be conducted in close accordance with the ODOT policy outlined 
below. 
 

ODOT Policy and Procedure  

 
Policy: 

1. THE FINAL ENGINEER’S ESTIMATE SHALL BE CONSIDERED AS 
INFORMATION CONFIDENTIAL TO ODOT. It is not to be shared with anyone 
other than appropriate ODOT project development personnel, contracted 
consulting staff, and Local Agencies and their consultants/agents. This 
confidentiality shall apply during all stages of project development up to the point 
of formal “notice to proceed” by ODOT’s Office of Procurement. 

2. This policy applies to all projects being publicly bid regardless of the method of 
PS&E delivery. 

3. It is not ODOT’s policy to voluntarily post or disclose in any form the FEE after 
contract award to the public. 

4. When requested, the release of the FEE is to be managed solely by OPL. 
5. After formal contract award the FEE will be made available to non-ODOT and 

non-Local Agency individuals and companies upon written request. This will be 
done on a project to project basis after approval to release is obtained from OPL. 
If a contract is not awarded the FEE shall remain confidential. 
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 Procedure: 

1. All members of a Project Development Team (PDT) have the responsibility to 
maintain the confidentiality of the project estimate from project inception through 
PS&E submittal and formal contract award. 

2. After PS&E pre-letting submittal, but before bid opening, a Cost Estimator within 
OPL will prepare the Final Engineer’s Estimate. During this process the following 
rules will be adhered to: 

a. The estimate will be reviewed and refined by an ODOT Cost Estimator 
into the Final Engineer’s Estimate. If the Cost Estimator needs clarification 
regarding any of the project parameters he/she will contact appropriate 
resources. For outsourced and local program projects, all necessary 
communication will be routed through the Project Leader (PL). 

b. The goal of setting the Final Engineer’s Estimate is to establish an 
estimate that is deemed to be a “fair” value for the project to the project 
“owner”. The Final Engineer’s Estimate considers factors such as, prior 
bid item cost history, project difficulty and locale, expected level of 
competition, current market pricing trends, magnitude of the project, 
uniqueness of the work, etc. 

c. An OPL Cost Estimator will communicate the final total value of the Final 
Engineer’s Estimate via confidential e-mail to the Project Leader no later 
than one week prior to bid opening. 

d. It shall be the responsibility of the PL to initiate any needed actions and/or 
responses to the Final Engineer’s Estimate. This includes confirmation of 
adequate funding if the FEE has increased the project cost above the 
programmed funding amount, as well as desired communication regarding 
significant estimate changes. 

e. In all cases, the ODOT Senior Cost Engineer has the final say in 
establishing the Final Engineer’s Estimate. 

3. Immediately after bid opening, OPL’s Cost Estimator will evaluate the submitted 
bids following the Bid Evaluation and Cost Justification Analysis. The Cost 
Estimator will consult with others within ODOT and/or the Consultant and/or the 
Local Agency, as needed, to develop their final recommendation. 

4. The final estimator’s recommendation shall be communicated to the OPO-
Construction Contracting Section via the Bid Evaluation template letter. This 
communication will contain confidential information and specifics regarding the 
Final Engineer’s Estimates and the evaluation of the bidder’s prices. 

a. In the case of a recommendation to award, the OPO-Construction 
Contracting Section will initiate the formal award process. 

b. In the case of a recommendation to reject the low bid or all bids, the OPO-
Construction Contracting Section will seek comment from the Region or 
local agency regarding this decision prior to making the final 
determination. 
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c. When a case arises where the Region or Local Agency disagrees with the 
Estimating Unit recommendation, detailed FEE information may be 
provided to appropriate individuals (i.e. Project Leader, Project Manager). 

5. The Bid Evaluation Letter also will contain recommendations regarding the 
monitoring of specific items and quantities during construction. If the bid is 
awarded, this information shall be forwarded by the OPO-Construction 
Contracting Section to the appropriate Project Manager for use during project 
construction. 
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Unbalanced Bids 

Mathematically and Materially Unbalanced Bids 

A mathematically unbalanced bid is a bid that contains lump sum or unit bid items that 
do not reflect reasonable actual costs or a reasonable proportionate share of the 
bidder’s anticipated profit, overhead costs, and other indirect costs. 
 
A materially unbalanced bid is a bid that generates reasonable doubt that award to the 
bidder (that submitted the mathematically unbalanced bid), will ultimately result in the 
lowest cost to the Federal Government. 
 
Note: A materially unbalanced bid must also be a mathematically unbalanced bid. A 
mathematically unbalanced bid is not necessarily a materially unbalanced bid, however. 
 
A mathematically unbalanced bid shifts the profits and/or costs from one item to other 
items in the bid schedule. This leaves the overall bid price competitive based on the 
plan’s estimated quantities. 
 
A materially unbalanced bid recognizes a potential error in plan quantities, or the 
potential to manipulate quantities during construction to maximize profits. A 
mathematically unbalanced unit price is then submitted on those items. The unit price 
bid will be high if quantities are expected to exceed plan quantities. The unit price bid 
will be low if the bidder plans on under-running quantities, otherwise not delivering, or 
re-negotiating a price or other item replacement strategy during construction. 
 
There are strong incentives for contractors to use unbalanced bidding in attempt to alter 
the order of the apparent low bid, thereby receiving award of the contract. There are 
also risks in that the bidder may be forced to produce precisely the estimated quantities, 
but these risks can be weighed against the possibilities of negotiating price agreements 
and change orders during construction. 
 
For more information on Unbalanced Bids refer to Chapter 7 of the Construction 
Manual. 
 

http://www.oregon.gov/ODOT/HWY/CONSTRUCTION/ConstructionManual/cm07.pdf
http://www.oregon.gov/ODOT/HWY/CONSTRUCTION/ConstructionManual/cm07.pdf
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Quality Control 

 
As defined by ODOT’s Quality Assurance Steering Team, quality control consists of 
“routine operational activities designed to consistently produce a predictable result.”  In 
creating an estimate, quality control involves an accumulation of activities designed to 
ensure adequate quality.  Quality control is necessary to ensure estimate errors are 
found and corrected.  
 
One way to improve quality control is to attend the Estimator Training Class and 
become familiar with this Estimating Manual. These resources make it easier to identify 
where mistakes often occur so that they can be avoided.   
 
To ensure all mistakes are found, double check the estimate against the specifications. 
Verify all bid item quantities and units match those given in the specifications. Errors in 
estimate quantities and units result in unforeseen costs and inaccurate estimates. 
 
If there is a bid item in the specifications that is new and not in the list of bid items in 
Estimator, select a bid item in Estimator that matches as closely as possible to the new 
bid item to ensure that the price is reasonable. Always, make sure that the 
supplemental description is filled out so contractors know what the bid item is for. 
 
Check for incidental work items. Consider whether incidental work items associated with 
one bid item could be broken into separate bid items. This will allow items to be bid 
more competitively. 
 
Reference the Common Mistakes section to check for additional errors. 
 
A quality control checklist is given in Appendix D outlining the quality control steps for 
project estimates. 

http://www.oregon.gov/ODOT/HWY/QA/index.shtml
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Construction Schedules 

 
The construction schedule is required as a legal document used in developing the 
contract completion date. It may also be used in the claims process if contract timing 
issues arise. The construction schedule is created by the designer of the project or the 
specification writer.  
 
Below is a list of steps on how to create the construction schedule by downloading from 
Estimator. 
 
How to create the construction schedule: 

1. Once the estimate has been created and is open in Estimator, click “File” in the 
top left hand corner of the screen, then “Export.” 

2. When the “Export” window opens ensure the “Save As Type” says EXCEL 
97/2003 WORKBOOK. Then click “Save.” The Excel file should automatically 
open with the data inserted into it. 

3. From this data, copy all the major items and insert them into the Excel file named 
Project Production Rates which can be found on the Specification Writers 
Template page of the ODOT website.  

4. Insert the item quantities into the production rate to get the average calendar 
days of work for each item. 

 
Once this has been completed, it can then be applied to Microsoft Project. This should 
be used to establish the contract completion date and the Construction Schedule. 
 
The construction schedule needs to show the bid date, completion date, and the time 
needed to complete major construction components of the project. This document 
needs to be updated when the estimate is revised. It is highly recommended that the 
Project Manager reviews the schedule to ensure it is achievable. The project team is 
responsible for keeping the official copy of the construction schedule with the official 
project file, in accordance with ODOT’s retention schedule (typically through completion 
of the project). 
 
The construction schedule is CONFIDENTIAL and is to be shared only with appropriate 
ODOT personnel. 
 
Build the Construction Schedule with the following items in mind: 

 Use quantities from the project estimate downloaded from Estimator as 
described above. 

 The schedule must be logical; the start of one activity is usually dependent on the 
completion of a previous activity. 

 What project activities will likely run concurrently? 

http://www.oregon.gov/ODOT/HWY/ESTIMATING/docs/LINK_TABLE1.xls
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 Review specifications sections 00290 (Work-In-Water, Noise, Environmental) 
limitations. Sections 00220 (Lane Closures, Night Time - Day Time work, 
Festivals, Parades, etc) 

 Establish schedule type (A,B, or C) 
 What, if any, limitations to On-Site work (00180.40(b)) are appropriate? 
 What are flagger and/or pilot car hours? 
 Will winter shut-down be required? If so, how long? 
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Appendix A 

Basic Steps to Create an Estimate 
 

1. Open the Trns•port Estimator®  Program 
2. Set Caps Lock 
3. Set all Mandatory Parameters, including all elements required on the Initial 

Estimate Page. 
4. Import the project skeleton file from the Trns•port PES/LAS® export folder. 
5. Expand estimate to show group categories identified in project folder – 

add/change/delete groups using standardized group numbers and naming 
conventions 

6. Add the project bid items under the appropriate groups. 
7. Add Anticipate Items (group 9400) and Construction Engineering Items (group 

9800). 
8. Add quantities to each of the bid items. Print without prices (“Hide Prices” in 

print options menu) for quantity/item Quality Control 
9. Add unit prices from designer for all items. 
10. Add “percent of estimate” reference prices for the LS items: Mobilization, 

TP&DT, Erosion Control, Survey, and Construction Engineering. 
11. Add cost breakdowns for incidental and lump sum items in the Cost Sheet price 

basis areas. 
12. Add other reference price information gathered by the estimator. 
13. Choose the final “active” price basis on analysis of all data. 
14. File naming for work in progress is the key # “xxxxxADV”. Save to the estimate 

folder. 
15. File name for PS&E estimate is the key # “xxxxxPS&E”. Save to the estimate 

folder. 
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Appendix B 

List of the Options for the Work Type: 
ASPH – Asphalt 
BASE – Base Course 
BRPT – Bridge Painting 
CONC – Concrete Paving 
CURB – Curb, Gutters & Sidewalks 
DBAS – Design Build - Asphalt 
DBMI – Design Build - Miscellaneous 
DBST – Design Build - Structures 
DRNG – Drainage 
EROC – Erosion Control 
ERTH – Earthwork 
FENC – Fencing 
GDRL – Guardrail 
GENC – General Construction 
HZRD – Hazardous Materials Disposal 
ITS – Intelligent Transportation System 
LSCP – Landscaping 
LTNG – Lighting 
MISC – Miscellaneous 
PVMK – Pavement Marking 
RMVL – Removal of Non-Structures 
RPRD – Rock Production 
SGNL – Signals 
SIGN – Signs 
STRC – Structures 
SURF – Surface Treatments
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Appendix C 

List of the Units of Measure in the Item Number: 
A = Lump Sum 
A = Foot or other measurement (Hybrid Lump Sum) 
E = Each 
F= Foot 
J = Square Yards 
K = Cubic Yards 
L = Mile 
M = Ton 
O = LB 
P = Gallons 
Q = M gallons 
R = Acre 
T = Hour 
U = Day 
V = Week 
W = Month 
X = Year
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Appendix D 

The following is a list of items that need to be checked when an estimate is close to 
completion. 
 

 Verify that all the bid items in the estimate match the items in the specification. 
 Verify that there is a Supplemental Description for items that are used to match 

new bid items in the specification. 
 Verify that the estimate quantities match the quantities in the specifications. 
 Verify all units against the specifications. 
 Check all incidental work items to make sure they are allowed in the 

specifications. 
 Check for incidental work items which could be separated into separate bid 

items. 
 Verify that the anticipated items have been approved. 

 



 

Appendix E 

  

Interoffice Memo 

January 30, 2004  

To:  Designers Project Leaders Transportation Design Managers Memo to Designers Manual Holders  

From:  s/Thomas Lauer, PE ODOT Roadway Engineer  

Cc:  Kathryn Ryan, Kevin Thiel, John Gernhauser - FHWA, Dale Horman - DOJ  

Subject: Management of the Engineer's Estimate (EE)  

PURPOSE: The purpose of this memo is to update and clarify the ODOT policy for managing the 
Engineer's Estimate (EE) for any public works project being awarded via the ODOT Construction 
Contracts Section.  

SCOPE: This policy addresses the confidentiality of ODOT construction project cost estimates from 
initial project inception through formal project construction contract award.  This policy applies to 
projects developed and engineered by ODOT internal staff, ODOT contracted consultants, Local 
Agencies and Local Agency consultants.  

HISTORY: The latest written ODOT policy regarding the management of the EE appears to be a memo 
written by H. S. Coulter, State Highway Engineer dated December 30, 1982.  Excerpting from this memo:  

"The Engineer's Estimates prepared for contract bidding comparisons, federal-aid 
programming, etc., are to be kept strictly confidential until the low bidder has executed 
the contract documents."  

While the referenced 1982 policy does not explicitly say it, the EE only becomes public information after 
formal contract award.  

The FHWA addresses the management of the EE in a variety of Technical Advisories but ultimately 
defers policy to the individual states. However, it is clear within the aforementioned technical advisories, 
and in conversation with FHWA staff, that they strongly prefer keeping the EE confidential. Regardless 
of the FHWA preferences, a few states do include the EE with bidding documents, the majority of states 
keep the EE confidential until project award (like Oregon), and still others never release the EE at all.  
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There are many different opinions and justifications, both pro and con, for keeping the EE confidential. 
Regardless, Oregon has no statutory requirements that control the EE either way.  Considering this fact, it 
is clear that the management of the EE is an ODOT Policy decision.  ODOT Executive Deputy Director, 
John Rosenberger, has recently re-affirmed the above 1982 State Highway Engineer policy decision after 
receiving counsel from Drummond Kahn, ODOT Internal Audits, and Dale Hormann, DOJ.  
 

Given the above background, the goal of the policy and procedure that follows is to communicate the 
expectations regarding the management of the EE now and in the future.  It departs somewhat from most 
policy statements, in that it does not attempt to describe the relative merits of the confidentiality decision, 
but rather, merely tries to clarify what this decision means operationally.  

POLICY:  

1. THE ENGINEER'S ESTIMATE SHALL BE CONSIDERED AS INFORMATION  
 CONFIDENTIAL TO ODOT. It is not to be shared with persons other than appropriate 

ODOT project development personnel, contracted consulting staff, and Local Agencies 
and their consultants/agents. This confidentiality shall apply during all stages of project 
development up to the point of formal “notice to proceed” by the ODOT Construction 
Contracting Section (CCS).  

  
2 This policy applies to ALL projects being publicly bid via the CCS regardless of the 

method of PS&E delivery.  
 
3 It is not ODOT’s policy to voluntarily post or disclose in any form the EE after contract 

award to the public.  
 
4 When requested, the release of the EE is to be managed solely by the CCS.  
 
5 After formal contract award the EE will be made available to non-ODOT and non-Local 

Agency individuals and companies upon written request.  This will be done on a project-
by-project basis after approval to release is obtained from the CCS.  In the case where a 
contract is not awarded, the EE shall remain confidential.  In all cases only the total value 
of the EE will be released after written approval from the CCS.  Unit prices under the EE 
should only be released subsequent to a freedom of information request and approval of 
release by both the Managers of the ODOT CCS and the ODOT Technical Services 
Branch.     
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DEFINITIONS:  

1. Definitions for the purpose of the following procedure:  

 Delivery Method    
Internal ODOT (IN 
sourced)  

External Consultant 
(OUT sourced)  

Local Program Produced  

Project Leader (PL) =  
ODOT Project Team 
Leader  

ODOT Consultant 
Project Manager (CPM) 
or ODOT Project Team 
Leader (PTL)  

ODOT Local Agency 
Program Liaison (LAPL)  

 
PROCEDURE:  

1. All members of a Project Development Team (PDT) have the responsibility to 
maintain the confidentiality of the project estimate from project inception, 
through PS&E submittal and formal contract award.  

2. After PS&E pre-letting submittal, but before bid opening, a Senior Estimating 
Engineer within the Technical Services Pre-Letting Unit will prepare the 
Engineers Estimate.  During this process, the following rules will be adhered to:  

a. The Project Estimate will be reviewed and refined by an ODOT Senior 
Estimating Engineer into the Engineer's Estimate. If the Senior Estimating 
Engineer needs clarification regarding any of the project parameters, 
he/she will contact appropriate resources. For outsourced and local 
program projects, all necessary communication will be routed through the 
Project Leader (PL).  

b. The goal of setting the final EE is to establish an estimate that is deemed 
to be a “fair” value for the project to the project “owner.” The EE 
considers factors such as; prior bid item cost history, project difficulty and 
locale, expected level of competition, current market pricing trends, 
magnitude of the project, uniqueness of work type, etc.  

c. The Senior Estimating Engineer will communicate the final total value of 
the EE via confidential e-mail to the Project Leader no later than one week 
prior to bid opening.  

d. It shall be the responsibility of the PL to initiate any needed actions and/or 
responses to Final EE. This includes confirmation of adequate funding if 
the EE has increased as well as desired communication regarding 
significant estimate changes.  

e. In all cases, the ODOT Final Estimator has the final say in establishing the 
EE.  
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3. Immediately after bid opening the Project Estimator will evaluate the submitted 
bids following the procedure outlined in the memo: "POLICY: Bid price 
evaluation and recommendation". The evaluator will consult with others within 
ODOT and/or the consultant and/or the local agency, as needed, to develop their 
final recommendation.  

 
4. The final estimator's recommendation shall be communicated to the Construction 

Contracts Manager via the Bid evaluation template letter.  This communication 
will contain confidential information and specifics regarding the Engineer’s 
Estimate and the evaluation of the bidder’s prices.  

a. In the case of a recommendation to award, the CCS will normally initiate 
the formal award process.  

b. In the case of a recommendation to reject the low bid, or all bids, the CCS 
will normally allow comment from the Region or Local Agency regarding 
this decision prior to making their final determination.  

c. Detailed EE information may be provided to appropriate individuals (i.e. 
Project Leader, Project Manager) in the case when the Region or Local 
Agency is considering a rebuttal to the Estimating Unit recommendation.  

 
5. The Bid Evaluation Letter also will contain recommendations regarding the 

monitoring of specific items and quantities during construction.  If the bid is 
awarded, this information shall be forwarded by the CCS to the appropriate 
Project Manager for use during project construction.  

 
POLICY Management of the Engineers Estimate1-30-04.doc  

 

http://www.oregon.gov/ODOT/HWY/SEOPL/docs/guides/bid-evaluation.pdf
http://www.oregon.gov/ODOT/HWY/SEOPL/docs/guides/bid-evaluation.pdf
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